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Glass Suction Tool  

Creating the Multibody Master Model 

Create a sketch using Corner Rectangle on the 

Front Plane.  

 

Make for Construction & Dimension as 

shown. 

 

Rename as ‘Construction Sketch’. 

 

 

Create a sketch on the Top Plane  

 

Sketch a Circle with the Centerpoint Coincident 

with outer edge of construction sketch. 

Dimension circle 95mm diameter. 

 

Rename as ‘Base Profile’. 

 

Create a sketch on the Right Plane. Sketch an Ellipse and add a 

Coincident relation to the top of the Construction 

Sketch.Add a Horizontal relation between the outer 

points of the ellipse. 

Dimension the ellipse as shown.  

 

Rename as ‘Ellipse Profile’. 

 

 



 

    Advanced SolidWorks 2019-2020 Page 4 

 

Create a sketch on the Front Plane.   

 

Select the Style Spline command and create a 4-point 

style spline as shown.  

 

Add a Vertical Relation to segment 1-2.  

 

Add a Horizontal Relation to segment 3-4. 

 

Add dimensions as shown. 

 

 

Add Pierce Relation between endpoint of Style Spline 

(Point 1) and Circle (Base Profile).  

 

Add Pierce Relation between endpoint of Style Spline 

(Point 4) and Ellipse (Ellipse Profile). 

 

Note: This relation ensures tangency when mirrored 

at a later stage. 

 

The Style Spline will now be fully defined.  

 

Rename as ‘Top Curve’. 

 

Create a New sketch on the Front Plane. 

 

Select the Style Spline command and create a 4-

point style spline as shown.  
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Add a Vertical Relation to segment 1-2.  

 

Add a Horizontal Relation to segment 3-4.  

 

Add dimensions as shown. 

 

Add Pierce Relation between endpoint of Style 

Spline (Point 1) and Circle (Base Profile).  

 

Add Pierce Relation between endpoint of Style 

Spline (Point 4) and Ellipse (Ellipse Profile). 

The Style Spline will now be fully defined.  

 

Rename as ‘Bottom curve’. 

 

 

 

Creating the Lofted Surface 

Select the Lofted Surface Command from the Surfaces 

toolbar.  

In the Profiles Tab select Base Profile & Ellipse profile 

from feature tree. 

In the Guide Curves Tab select Top Curve & Bottom 

Curve. 

 

Select the drop down arrow under Start/End Constraints. 

Select Normal to Profile under both Start and End Constraints. 

 

 

 

 

 

Surfaces 
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Note; Normal to profile will give a more accurate curve 

type. 

In the Guide Curves Tab, Select To Next Guide under guide 

curves influence type.  

Select None for Bottom Selection. 

 

Select OK to accept the surface produced.  

 

Rename Feature as ‘Main Body Loft’. 

 

 

Adding a Thickness to the surface 

 

Select Thicken from the Surface toobar.  

 

Under the Thicken Parameters Tab, You are required 

to select a Surface to thicken, Select Main Body Loft 

from the feature tree. 

 

Note; Under the Thickness Tab there are three options.  

 

Select Thicken Both Sides. 

Select 1mm Thickness. 

 

Select OK to accept the feature. 

 

Rename as ‘Thicken Main Body’. 

Creating a Split Line Feature 

 

Create a Sketch on the Top Plane. 

Thickness 

Thicken 
Thicken Both 

Thicken 
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Select Convert Entities and select the construction sketch. (Centerline).  Under options Tick 

the for Construction check box, select ok.  

 

Select Circle command and draw circle, add a 

Coincident Relation between the centre of the 

circle and end centerline.  

 

Select Line Command and Draw Horizontal And 

Vertical Line as shown opposite. 

Dimension as shown opposite. 

Select Mirror entities, Mirror the Horizontal and 

Vertical lines about the centerline.  

 

Select Trim Entities and use Power trim to remove 

inner segments of circle.  

 

 

Select Extend Entities to extend centerline to Outer 

edge of Circle. 

 

 

 

Select Ellipse and sketch an ellipse Coincident to the centerline as shown opposite.  

 

 

Add a Vertical Relation between the outer points 

of the major axis. 

 

 

Dimension as shown opposite.  
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Select Trim Entities and remove inner segments of 

circle and ellipse.  

 

 

Select Sketch Fillet from the sketch tools, select the 

intersection point between the circle and 

the horizontal lines. 

 

Set the Fillet Parameters to 40mm.  

 

Select OK to accept the fillet. 

 

The sketch is now fully defined. 

Rename as ‘Split Sketch’. 

 

 

Creating a split on the Body 

 

Select Surfaces toolbar and go to Curves, Under the Curves drop down select Split Line.  

Under the Split Line Tab, select Projection. 

Under the Sketch tab, select Split Sketch from feature 

tree.  

 

Under the Faces tab, select the outer face of the 

body.  

 

Select OK to accept the Split line. 

The Face selected has now been Split into seperate 

surfaces.  
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Click on the face to identify the Surfaces. 

Rename Split Feature as ‘Split Top Surface’. 

Offsetting the New Surface 

 

Note; Solidwork will not permit the user to work with the existing 

surface that has been created as this belongs to the existing body, 

the user must create a new surface. To do this the Offset Surface 

Feature is used. This feature acts like a copy button, The offset 

surface can be controlled by direction and distance. 

 

Select the Surface that was Split. 

 

From the surfaces toolbar select Offset Surface Feature.  

Under the Offset Surface, Set offset distance to 0.5mm. 

 

Select OK to Accept the Offset Surface. 

 

Rename as ‘Top Surface Offset’. 

 

Note: The Flip Offset Direction is automatically set to offset to the outside of the Surface. 

Should the user need to change this to the inside, this button can be used to Flip Offset 

direction. 

Note; If the user required the surface to remain flush with the existing surface you could set 

the offset distance to zero. This will copy the existing surface and allow the user to use the 

new surface for other features.  

Adding a Thickness to the new offset surface. 

 

Select the ‘Top Surface Offset’ from the feature tree.  

 

From the Surfaces toolbar select Thicken. 
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Set Thicken Parameters to; 

Thicken Side 2 

Thickness 1mm. 

Untick the Merge result 

 

Select OK & rename as ‘Top Surface Thicken’. 

 

Note; At this stage by deselecting the merge result, a new solid body will be formed 

containg the top surface. This style of  modelling is known as Multbody Modelling. 

 

All solid bodies created in this manner can be saved as individual parts at any stage. 

It is good practice to create the full multibody and save the bodies as new parts when all 

editing has been finalised. 

 

Viewing the Solid Bodies 

 

From the feature tree select Solid bodies folder.  

Two seperate bodies can now be seen in this folder. While these appear as two seperate 

bodies they can be saved as seperate parts at a later stage. 

 

Note; The name of the solid body is derived from the name of the last feature created on 

this body. The names of the solid bodies can be changed at any stage. 

 

Using the Indent Feature 

The indent feature will now be used to take a cut in the shape of 

the Top Surface directly out of the Main Body resulting in two 

bodies that will fit perfectly into each other. 

Note; The indent Feature can be found under the Insert Tab > 

Features > Indent. 

 



 

    Advanced SolidWorks 2019-2020 Page 11 

 

Select Indent 

 

Under the Indent Parameter select; 

Target Body as Select face of Main Body. 

Tool Body Region as Select face of Top Surface. 

Tick the Cut Checkbox. 

 

Select Ok & rename feature as ‘Indent top’. 

 

To view the resulting feature select 

Top Surface Thicken from the Solid 

Bodies folder. 

 

Select Hide. 

 

The resulting effect of the indent feature can be seen. 

 

Select Show Top Surface Thicken to resume editing. 

 

 

 

Creating the Button 

 

Create a Sketch on the Top Plane. 

Select Convert Entities and select the construction 

sketch. (Centerline).  Under options Tick the for Construction 

check box, select ok.  

 

Sketch a Centerpoint Straight Slot with the centerpoint 

Coincident with the Outer edge of the Construction sketch.  

 

Dimension as shown opposite. 
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Exit Sketch & Rename as ‘Button Sketch’. 

 

Select Split line from the Curves toolbar.  

 

Type Projection 

 

Under Sketch select Button Sketch sketch. 

 

Under face Select the Top Face of Top Surface thicken. 

 

Select OK. 

 

Rename feature as ‘Split Button’.  

 

Select the Surface that was Split.  

 

From the surfaces toolbar select Offset Surface Feature.  

Under the Offset Surface, Set offset distance to 0.2mm.  

Select OK to Accept the Offset Surface. 

 

Rename as ‘Offset Button’. 

 

Adding a Thickness to the Button offset. 

 

Select the ‘Offset Button’ from the feature tree.  

From the Surfaces toolbar select Thicken. 

Set Thicken Parameters to;  

 

Thicken Side 2 – 0.5mm 

Untick the Merge result. 

Accept and rename as ‘Thicken Button’. 
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In the feature tree under Solid Bodies folder, three 

Solid Bodies can now be seen.  

 

Hide the three Solid Bodies in the Solid Bodies 

folder.  

 

Adding the Arrors to the Button 

 

Create a Sketch on the Top Plane. 

 

Select Convert Entities and select the Button sketch from the feature tree.  Under options 

Tick the for Construction check box, select ok. (To be used as a guide) 

 

Select Centerline and sketch from center to center 

of slot curves.  

 

Select Line and create sketch starting on the end of 

the centerline as shown opposite.  

 

Add Parallel & Perpindicular Relations between the lines. 

 

Dimension as shown. 

 

Mirror the Entities using the centerline. 

 

 

Select Linear Sketch Pattern from sketch tools. 

 

Set Entities to pattern – Select arrow (Tip – Select a point inside arrow 

to automatically select all lines) 

 

Mirror 
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Set Direction 1 to the centerline 

 

Set D1 to 7mm 

  

Set Instances to 7. 

 

 

Select OK to accept the pattern 

 

Rename as ‘Arrows’. 

In the feature tree under Solid Bodies Folder. 

 

Show the three Solid Bodies in the Solid Bodies 

folder.  

Select the Arrows sketch from the feature tree. 

 

Select Extruded Boss/Base 

Set The following parameters;  

From – Surface/Face/Plane 

Surface – Select top face of button 

Select – Blind & Distance 1 – 0.2mm 

 

Under Feature Scope – Tick selected Bodies 

 

Untick Auto-select 

 

Select the body to merge with from the 

feature tree – Thicken Button 

 

 

 

Select Top Face of Button 
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Note; This is an important feature of the extrude boss/base, it allows the user to select 

which of the bodies to merge with. If all bodies was selected it would merge all bodies in the 

entire model resulting in a single solid body.  

 

Select Ok to accept the feature & rename as ‘Arrow Extrude’. 

 

Indent Feature for Button 

Select Indent Feature – Insert>Features>Indent 

Under the Indent Parameter select;  

 

Target Body as Top Surface/Split Button.  

 

Tool Body Region as Button.  

 

Tick the Cut Checkbox. 

 

Under Parameters; 

Set the thickness to 0.2mm 

Select Ok & rename as ‘Indent Button’. 

 

Note; The thickness parameter can be used to create a gap between the two bodies in the 

indent. The gap is created around the outside of the bodies and between the bodies. 

 

 

Revolving the Bottom of the Suction Cup 

 

Create a Section View using the Front 

Plane.  

 

Select OK. 
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Create a sketch on the Front Plane and Convert Entities for base line. 

Select Line and complete sketch as 

shown opposite.  

 

 

Select Circle and sketch a circle with its 

centerpoint Coincident to the outer 

corner of the model.  

Dimension as shown. 

 

Select Trim Entities and remove as Shown opposite.  

Trim right side of converted entity line. 

Dimension Angle as shown to fully define sketch. 

 

Rename as ‘Inner Section’. 

 

 

Select Revolved Boss/Base 

Select the 22mm line as axis of reveloution  

 

Select Parameters as shown below; 

 

In the Feature Scope 

Set to Selected Bodies 

Untick Auto-select 

 

Select Indent Top from feature tree as the Selected Body. 

 

Select OK & rename as ‘Revolve Base’. 

 

 

 

Use Convert Entities for this 
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Creation the Bottom Suction Cup 

 

Create a sketch on the Front Plane using the line 

command. Make first point of line Coincicent with midpoint 

of previous revolve. 

 

Dimension as Shown. 

 

Select Revolve Boss/Base 

 

Set the 10mm line as the 

axis of revolution.  

 

Untick the Merge result tickbox.  

 

This will form a new Solid Body. 

 

Select OK to accept. 

 

Rename as ‘Base Suction Cup’. 

 

 

Select Indent Feature 

 

Select the Revolve Base as the Target Body. 

 

Select the Base Suction Cup as the Tool 

body region. 

 

Tick the Cut checkbox. 

 

Start 
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Note; In this instance space is not required between the two bodies so the gap setting will 

be set to zero. 

 

Rename as ‘Indent Main Body’. 

 

Turn Off Section View. 

 

Adding a Grip Tab to the Suction Cup 

 

Create a sketch on the Front Plane as shown opposite.  

 

Select Centerline and sketch a Vertical centerline with a 

coincident on the corner of the suction cup and a Horizontal 

centerline. 

Dimension as shown.  

Select Centerpoint arc to complete the 

arc. 

Select Revolved Surface. 

 

Use Centerline from Construction sketch 

as axis of revolution.  

 

Set Revole Parameters as shown opposite. 

Select OK & rename as ‘Revolve Tab’.  

 

Create a sketch on the Bottom Surface of the Suction 

Cup.  

Select Centerline and sketch from Construction sketch 

to edge of surface.  

Select Ellipse and sketch Ellipse with Major axis 

Coincident with Centerline. 
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Dimension as shown.  

Rename sketch as ‘Tab Sketch’. 

 

Select Split line command from Curves 

toolbar.  

Select Tab sketch 

Select Face of surface 

 

Select Ok to accept. 

 

Rename as ‘Tab Surface’. 

 

Select the Tab portion of the 

Surface.  

 

Select Offset Surface. 

 

Create a 2mm offset to the 

underside of the surface. 

Select Ok. 

Rename as ‘Tab Offset’.  

 

Select Tab Surface from Feature tree & Hide surface. 

 

Select Thicken 

 

Set Parameters as shown opposite. 

 

Rename as ‘Thicken Tab’. 
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Select the underside face of the suction cup. 

 

Select the Dome feature. 

 

Reverse Direction. 

 

Select OK to accept &rename as ‘Dome Underside’. 

 

Select Fillet. 

Add a 5mm Fillet each side of the Tab.  

 

Rename as Fillet Tab Edge. 

 

Select Fillet 

 

Add a 0.5mm fillet to the top edge of the suction cup.  

 

Rename as Fillet Suction Top.  

 

Select Top Edge of Button.  

 

Select Fillet. 

 

Add a 0.5 mm Fillet. 

 

Rename as ‘Button Fillet’. 
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Mirror Solid Bodies 

Select Mirror from the features toolbar. 

 

Set Mirror parameters as shown opposite.  

Select OK. 

Rename as ‘Mirror Bodies’. 

 

 

Select Combine Feature 

Select Add 

 

Select the Top Surfaces 

 

Select OK & rename as ‘Top Casing’. 

 

 

Select Combine Feature 

Select Add 

 

Select the Main Body and Mirror 

 

Select OK & rename as ‘Main Body’. 

 

 

Creating a Grip 

 

Create a Sketch on the Top Plane. 

 

Select Convert Entities and select the Construction sketch from the feature tree.  Under 

options Tick the for Construction check box, select ok.  
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Select these two edges 

Select Centerpoint slot Coincident with Origin and side point Coincident with the centerline 

converted. 

 

Dimension as shown. 

 

Rename as ‘Grip Split Line’. 

 

 

Select Split Line from Curves toolbar. 

 

Set Parameters as shown.  

 

Ensure both faces are selected. 

 

Select OK & rename as ‘Grip Split’.  

 

 

 

Using the Deform Tool To Create Grips 

 

Create a sketch on the Front Plane. 

 

Select Convert Entities and select both edge curves.  

 

Rename as ‘Initial Curve’. 

 

 

Create a sketch on the Front Plane.  
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Create a Spline as shown in 

the sketch opposite. Ensure 

start and end point of spline 

are Coincident with Initial 

Sketch.  

 

Add a Horizontal Relation to both ends of the spline handles.  

 

 

 

 

 

Rename as ‘Target Curve’.  

 

Note; Try to keep the spline just outside and inside the body for this feature. 

 

 

Select Deform Feature  

 

Insert>Features>Deform 

 

Select Curve to Curve  

 

Select Initial Curve  

 

Select Target Curve  

 

Select fixed Edges 

 

Select OK to accept.  

 

Rename as ‘Deform Grip’. 

Select the edges that 

surround the deform area. 

Six edges surround the area. 
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Hide Initial Sketch and Target Sketch in feature 

tree. 

 

Note; Use Section View – Front Plane to best 

view Grip. 

 

 

Creating a Design around the grip. 

 

Select Grip Split Line sketch. 

 

Select Projected Curve from Curves 

toolbar. 

 

Select faces to project onto as shown. 

 

Select OK and Rename as ‘Projected Curve’. 

 

 

Select Feature Swept Boss/Base 

Select Projected curve 

 

Select Circular Profile  

Set Diameter – 3mm 

 

Select OK and Rename as ‘Grip Sweep’. 

 

Hide the Projected Curve. 

 

Hide the Construction Sketch.  
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Renaming The Solid Bodies 

Rename each Solid Body as shown below. 

 

 

 

 

 

 

 

 

 

 

Adding Appearances 

 

Add suitable appearances to each solid body. 

 

Saving the Bodies 

 

There are two methods of saving the bodies. 

 

Method 1 

Right Click on the Solid Body in the Solid Bodies 

Folder.  

 

Select Insert into New Part. 

Tick Propagate visual properties. 

Tick Override default template settings. 

File Name – Leave blank. 

Select OK. 

Bottom Casing 

Suction Cup Right 

Top Casing 

Button Right 

Button Left 

Suction Cup Left 
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The Solid body will now appear as a new part file. 

 

The Save as dialog box will appear – It will automatically create a name for the part linked 

to the name of the Solid Body. 

 

Select Save. 

 

Note; The new part will automatically be saved into the same folder/location as the master 

model. Only tick propagate visual properties if you want to carry appearances/decals into 

the new part. 

 

Repeat this Process for all solid bodies. 

 

Create an Assembly & Insert Parts into  the Assembly. 

 

Parts can be mated using planes. (front to front) 

 

This will create an identical setup to the Master Model. 

 

Note; All mating can be achieved as if mating any set of parts. 

 

Note; When Solid Bodies are inserted into a new part, they retain the parametric link to the 

Master. This is important to note as any changes carried out in the Master Model will 

automatically update in the new part or assembly. 

Any changes made in the part files will not be linked to the master model, these changes will 

be seen in the assembly. This can be used to an advantage for making different versions of a 

part. 
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Method 2  

 

Save Bodies Feature 

 

In the Master Model 

 

Select Insert> Features > Save Bodies. 

 

Tick the Bodies to Save. 

 

In this case all 6 bodies should be ticked. 

 

Untick Consume Cut Bodies. 

 

Tick propagate Visual Properties. 

 

Under Create Assembly 

 

Select Browse 

 

Specify the file name and location for the assembly. 

 

Select Save. 

 

Select OK on the save bodies feature.  

 

Solidworks will automatically save each solid 

body as a new part file, it will also create an 

assembly of all the part files. 

 

Notes;  

All parts are fixed in the exact position from the master model. 

Assembly Environment 

Parts are all fixed 
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If changes are required in the Master Model it is important to look at 

the feature tree. 

 

A new feature was created when Save Bodies was used. 

 

In order to retain a parametric link to the assembly, any further 

changes must be created before the Save Bodies Feature. 
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SolidWorks Visualize 

Professional 

 

 

 

 

 

 

Importing & CAD Live-Update 

 

It is essential to understand the importing process in SolidWorks Visualize to control the 

import settings and the organisation of the original CAD files  

There are two common import settings to setup a Visualize project for different workflows 

one to make a model quick and easy to work the other to allow live updates and more 

flexibility. 

This presentation will focus in on the workflow that allows the appearances applied to 

Parts/Assemblies in SolidWorks to Live Update in Visualize. Note reference will be made to 

the quick and easy workflow (www.mysolidworks.com) at a later stage 
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General User Interface Of Visualize 

  

Importing CAD files into 

Visualize 

Open the CAD files Watch-curve-

blue and apply appearances save 

the file as normal. 

 

Select the Visualize Icon (Desktop) 

 

 
 
 
 
 
 
Select the icon create New Project  
and save. 
  

Palette 

Heads Up Display 

Main Toolbar

bar 

Viewport 
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Importing CAD File Option 1 

In the New Project window open 

the folder with the contains the file  

Watch-curve-blue drag the file  

into the new project window. 

 

 

 

 

Importing CAD File Option 2 

Select File top left and scroll  
down to import. 
 
 
 
 
 
 
Import window 
 
 
 
 
 
Import Settings Checked 
 

 Geometry 
 Appearances 
 Scene  
 Decals 
o Animations 
o Camera 
 Automatic 
 Monitor File 
 Snap to Floor 

 
 



 

    Advanced SolidWorks 2019-2020 Page 32 

 

Imported SolidWorks files 
with settings applied 

 
 
 
 

 

 

 

 

Toggle between  

SolidWorks & Visualize (Alt Tab) 

 

 

 

 

 

 

 

 

 
Edit a part in SolidWorks, Visualize will prompt to Update Live 

 

 

 

 

 

 

 

 

 

 

 

SolidWorks Edit Visualize Live Update 



 

    Advanced SolidWorks 2019-2020 Page 33 

 

Saving an Image from Visualize 

 

Select the Output Icon from the Main Toolbar  

this will bring up the Output Tools 

 

 

Output Tools  

o File Name:  Appropriate Name for Image 

o Output Folder:  Location to save file 

o Image Format: JPEG 

o Output Mode:  Render 

o Render Output Passes: None 

o Start Render  

 

             

 

 

Render Completed 

On completion of  the render you can select  

a link to find the location of the file with you  

have pointed to in the Output Tools Settings 
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Editing the SolidWorks Model 

Main Toolbar 

o Renderer Selection 

o Turntable 

o Selection Tool 

o Object Manipulation Tool 

o Camera Tool 

o View Presets 

o Output Tool 

 

Showing and Hide Parts 

Select the Models Icon 

 

 

 

 

 

 

 

 

 

Select a Part and on the right  

select the Show/Hide 
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SolidWorks Parts Hidden 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Inserting Textures  

Select File Library and Textures 
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Drag Brushed Normal into the  

Project Window 
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www.mysolidworks.com 

Login using Existing SolidWorks Account 

Create a New Account using SolidWorks Serial Number 

 

 

 

 

 

 

  

Search for Visualize 

 

 

 

 

 

 

 

 

 

 

http://www.mysolidworks.com/
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Training Materials 

https://my.solidworks.com/training/path/61 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://my.solidworks.com/training/path/61
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https://my.solidworks.com/training/lessonviewer/19-ENG-VIS-0001/ 

https://my.solidworks.com/training/master/333/1/0/toolbar%2C+raytracing%2C+and+gene

ral+ui 

 

 

https://my.solidworks.com/training/lessonviewer/19-ENG-VIS-0001/
https://my.solidworks.com/training/master/333/1/0/toolbar%2C+raytracing%2C+and+general+ui
https://my.solidworks.com/training/master/333/1/0/toolbar%2C+raytracing%2C+and+general+ui
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Create Text & Image Decals using 

PowerPoint 

Create a text box insert Text and Images 

Format the text box. 

Background Black 

Text White 

Image White 

 

 

 

 

 

 

 

Group Text and Image 

 

 

 

 

 

 

 

Right click Save as Picture 
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